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Warranty 2
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of shipment. If
any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product without charge for parts
and labor, or will provide a replacement in exchange for the defective product. Parts, modules and replacement products used by Tektronix for
warranty work may be new or reconditioned to like new performance. All replaced parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period and make
suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective product to the service
center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties,
taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Tektronix
shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than Tektronix
representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to incompatible equipment; c) to
repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with
other products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY
PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS
ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component
manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it must remain
accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Replace Batteries Properly. Replace batteries only with the specified type and rating.
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General Safety Summary

Recharge Batteries Properly. Recharge batteries for the recommended charge cycle only.

Use Proper AC Adapter. Use only the AC adapter specified for this product.

Do Not Operate in an Explosive Atmosphere.

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.
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General Safety Summary

The following symbol(s) may appear on the product:
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Environmental Considerations

Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life. In
order to avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the European Union’s requirements according to Directive
2002/96/EC on waste electrical and electronic equipment (WEEE). For information about recycling options, check
the Support/Service section of the Tektronix Web site (www.tektronix.com).

Battery Recycling. This product contains a lithium ion (Li-ion) rechargeable battery, which must be recycled or disposed of
properly. Please properly dispose of or recycle the battery according to local government regulations.

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, the Electronics Industries
Alliance (www.eiae.org) for disposal or recycling information.
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Environmental Considerations

Perchlorate Materials. This product contains one or more type CR lithium coin cell batteries. According to the
state of California, CR lithium coin cells are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Transporting Batteries
The lithium ion rechargeable battery pack in this product contains less than 8 grams of equivalent lithium content, with individual
cells containing less than 1.5 grams of equivalent lithium, as measured by International Civil Aviation Organization (ICAO)
standards. Consult your air carrier for applicability and determination of any special lithium ion battery transportation requirements.

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS Directive.
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Preface

Preface
This manual describes the installation and basic operation of the Y500 Spectrum Analyzer. For more detailed information on
specific fields, tap the help buttons in the application to open the online help for those items.

Key Features
The Y500 Spectrum Analyzer is a rugged, multi-standard spectrum analyzer and interference mapping tool optimized for field
use. Key features include:

Spectrum analyzer input frequency range of 10 kHz to 6.2 GHz covers most modern signal sources

DPX™ Spectrum color bitmap display that shows signal rate-of-occurrence and trace shape changes to help highlight
short-duration signal features

Plot measurements directly onto geo-referenced maps (using GPS) or image maps for on-site analysis of interference and
coverage problems

Multiple signal markers, signal traces, and trace modes provide flexible measurement capabilities

Spectrogram display for detection of intermittent signals

Key RF measurements
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Preface

Documentation
To read about Use these documents
Installation and operation (overviews) Y500 Spectrum Analyzer User Manual. The user manual contains general information

about how to put your instrument into service, guides to user interface controls, and
application examples.

Help using the application Online Help. The online help is context sensitive, displaying information appropriate
for the active screen or the selected help button. (See page 27, Getting Help.)
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Preface

Software Upgrades
Periodic software upgrades may become available. The software is operational only if you have a valid option key for the specific
application module and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Click Software Downloads on left side of the screen to link to the Software Downloads Web page.

3. Enter the product name or model number in the Search by keyword field and click Go.

4. Scroll through the list and select the appropriate link for your instrument to show more information or to download the software.

The instructions to perform the software upgrade are in the readme.txt file that is part of the software download.

Conventions Used in This Manual
The following icons are used in this manual:

Sequence
Step

Front panel
power

Connect
power
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Preface

Preventing Personal Injury from Lightning

WARNING. To prevent personal injury from the effects of lightning, exercise the following precautions when using this product:

Before connecting this product to any source
Check your local weather forecast for the possibility of thunderstorms or lightning.

If weather conditions could allow thunderstorms or lightning to develop, be sure to visually check the sky and weather
conditions in your area frequently.

If you can hear thunder or if you see lightning, do not connect this product to any source which may be exposed to the
effects of lightning.

Use your own good judgement and common sense. You must protect yourself from the effects of lightning.

You must assume that hazardous voltages will be present on exposed surfaces of this product if it is connected to a source
exposed to lightning. The insulation of this product will not protect you from these hazardous voltages.
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Preface

Do not connect this product to any source which might be subject to the effects of lightning
If thunderstorms or lightning are in your vicinity:

When weather conditions that could lead to lightning activity exist in your area, you could be at risk of a lightning strike
before the cloud is close enough for you to hear thunder or see lightning.

When lightning strikes a structure or facility, current travels through rebar, concrete, pipes, cables, vent stacks, and electrical
system.

Lightning can induce electric and magnetic fields into structures and portions of wiring. The length of a conductor affected by
the magnetic field of a lightning strike may exceed two miles.

Be alert and aware of the effects of lightning
When lightning strikes a conductor, which in turn introduces the current into an area some distance from the ground strike point,
equipment can be damaged and personnel injured if they become an indirect path in the completion of the ground circuit.

Conductors such as the braided shields of cables or unshielded wires will have significant transient currents flowing in them
in regions exposed to the electric field effect of lightning.

Induced voltages may cause breakdown of insulation in wiring at connectors and in electrical components or breakdown of air.
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Installation

Installation
Carefully unpack your instrument and verify that it includes the standard accessories.

Y500 Spectrum Analyzer Standard Accessories
Accessory Tektronix part number
Y500 instrument Y500
Y500 Spectrum Analyzer User Manual 071-2299-xx
AC Power Adapter 119-7288-xx
Lithium-Ion Battery 146-0151-xx
GPS Antenna 119-7424-xx
Tilt stand 348-1661-xx
Soft carry case 016-1775-xx
BNC Connector cover (2) 200-0678-xx
N Connector cover (1) 200-4696-xx
Audio jack mute plug (mute all audio output from the instrument speaker) 131-8284-xx

Your instrument may also include optional accessories. Verify that the optional accessories you ordered are included with your
instrument. For a current list of accessories, upgrades, and options, including service options, available for your instrument,
visit the Tektronix Web site, www.tektronix.com.
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Installation

Operating Considerations
AC Adapter Input voltage and current: 100 V - 240 V AC, 1.8 A

Input frequency: 47 Hz to 63 Hz
Output voltage and current: 24 V DC, 3 A

Dimensions Height: 25.5 cm. (10.0 in)
Width: 33 cm. (13 in)
Depth: 12.5 cm. (4.8 in)

Weight Weight: 6.0 kg (13.25 lbs) , instrument and one battery
Temperature Range Operating: 0 °C to +50 °C specified performance, –10 °C to +50 °C typical

Nonoperating: –40 °C to +60 °C
Humidity Operating and Nonoperating: 5% to 95% relative humidity (RH) at up to +30 °C, 5% to 45% RH above

+30 °C up to +50 °C, noncondensing
Altitude Operating: Up to 4,600 m (15,092 ft.)

Nonoperating: Up to 12,192 m (40,000 ft.)
RF Signal Input Input frequency range: 10 kHz to 6.2 GHz

Coupling: AC
Input impedance: 50 Ω (nominal)
Maximum input power without damaging instrument: 50 W rms 10 kHz to 3.2 GHz, 15 W rms 3.2 GHz
to 6.2 GHz
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Installation

Cleaning
Clean the exterior surfaces of the instrument with a dry lint-free cloth or a soft-bristle brush.

Use a cloth or swab moistened with deionized or distilled water, or a 75% isopropyl alcohol solution for more stubborn stains, to
clean the instrument or touch screen; use just enough moisture to dampen the cloth or swab.

Use a gentle amount of force when cleaning the touch screen.

CAUTION. Do not get moisture inside the instrument during exterior cleaning.

Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument.

Do not spray liquids directly on the instrument or touch screen.

Do not use abrasive cleaners, or chemical cleaning agents that contain benzene, toluene, xylene, acetone, or similar solvents; they
can damage the instrument or touch screen. Do not use commercial glass cleaners to clean the touch screen.

Do not scrub the touch screen with excessive force while cleaning.
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Installation

Installing Batteries
The instrument comes standard with a single battery, which is not installed when the instrument is shipped. To install the battery, do
the following:

1. Push on the battery door latch, then open
the battery door.

2. Push the metal battery retainer tab down
and towards the back of the instrument.

3. Lift the battery retainer up.
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Installation

4. Lift battery by the tab.

5. Insert the battery, oriented as shown, into
either battery slot.

6. Close and latch the metallic battery retainer
and the battery compartment door.

7. Reverse steps 1 through 6 to remove a
battery.

You can add a second battery to increase the operating time. Replace a battery with the specified type only. To purchase a battery,
contact your Tektronix Service Center for the correct part number.

NOTE. Disconnect power supply cables from the instrument before installing or removing batteries.

New batteries, or batteries that have not been used for an extended period, must be charged before using them to power the
instrument. (See page 7, Charging the Batteries.)
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Installation

Connecting the AC Adapter
1. Lift the instrument strap to expose the

power adapter connector.

2. Connect the AC power adapter to the
instrument.

3. Connect the AC adapter to a
properly-grounded AC power source
using the provided power cord.

4. Charge the batteries before using the
instrument on battery power for the first
time. (See page 7, Charging the Batteries.)
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Installation

Charging the Batteries
Charge the batteries before using the instrument on battery power for the first time. Batteries are partially charged and calibrated
at the factory. A calibrated battery allows the instrument to more accurately estimate how long the application modules can
operate before the instrument automatically powers off. The front-panel BATTERIES charge status indicator turns off when
charging is complete.

See the Y500 application online help topic Battery Calibration for information on calibrating batteries.

Approximate charge time

Number of batteries Instrument powered on Instrument powered off
1 10 hours 5.5 hours
2 20 hours 11 hours

NOTE. These are typical numbers for batteries that are low but not completely discharged.
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Powering On and Off the Instrument, and Functional Verification
1. Tap the On/Standby button to power on

the instrument.
The instrument WindowsCE Status bar
shows the Battery icon when the instrument
is operating on battery power and the
External Power Connected icon when the
instrument is operating with an external
adapter.
To power off the instrument, tap the
On/Standby button again.
For information on the instrument
on/standby power modes, see the online
help: Start > Help > Tektronix Basics >
Shutting Down the Instrument.

2. For functional verification, watch the
screen. Verify that the instrument does
not display any power-on diagnostic error
messages.
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Touch Screen Concepts
The instrument user interface is based on touch screen technology. Instead of using physical button and knob controls to select
functions, set values, and take measurements, you tap (touch) virtual controls on the instrument screen. Virtual controls behave
the same way as physical controls.

The following are touch screen terms used in this manual:

Term Description Equivalent mouse operation
Stylus The physical object you use to touch the screen. A stylus is either

your finger or an appropriate plastic-tipped stylus. Do not use any
metal-tipped objects or pens for a stylus, as they can damage
the touch screen.

The mouse pointer.

Tap Touch the screen briefly with the stylus. Selects the item on the
screen.

The left mouse button.

Drag Press and hold on the screen with the stylus, drag the stylus to a
new position, and then raise the stylus from the screen. Moves an
item or selects an area.

Drag (hold down the left mouse
button, move the mouse, and then
release the button).
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Calibrate the Touch Screen
Before using the instrument for the first time, calibrate the touch screen display to respond correctly to your taps.

1. Tap Start > Settings > Control Panel to
open the Control Panel screen.

2. Double-tap the Stylus icon on the Control
Panel screen.

3. In the Double-Tap tab, double-tap the
checkerboard grid at a comfortable speed
with your stylus or finger to set the tap rate.

4. Double-tap the test icon to verify your
settings.
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5. Tap the Calibration tab and read the
instructions.

6. Tap the Recalibrate button to open the
Cursor Position target screen.

7. Follow the target screen instructions.
When the position target disappears, touch
anywhere on the screen to return to the
Calibration tab.

8. Tap OK to save calibration settings.
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Starting the Y500 Spectrum Analyzer Application
If purchased with preloaded software, the Y500 application starts automatically when you power on the instrument. If the
Y500 application does not start automatically, or you have stopped the application, use either of the following methods to start
the application:

Double-tap the Y500 icon on the instrument
screen.

Select Start > Programs > Tektronix
Applications > Y500.

The instrument opens the application. The
Microsoft WindowsCE taskbar displays a
button for each running application. To bring
the application to the front of the screen, tap
the Y500 button in the taskbar.
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Setting Display Colors
You can change the color scheme used in the instrument display. The color schemes optimize the display colors for use in different
environments (outdoors or indoors) and for better printing quality on black and white (monochrome) printers.

1. Select Setup > Color Preferences.

2. Tap the Color Scheme list field and select
a display color scheme.

3. Tap OK.

4. Select File > Exit to close the application.

5. Restart the application to enable the
changed color scheme.

Y500 Spectrum Analyzer User Manual 13
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Getting Acquainted with Your Instrument
Instrument Elements

1. Battery compartment.

2. Signal Connectors. (See page 17, Signal
Connectors.)

3. Input/Output ports. (See page 16,
Input/Output Connectors.)

4. PCMCIA card ports.

5. Power and Status panel. (See page 15,
Power On/Standby and Status Panel.)

6. Connector for external power adapter.
(See page 6, Connecting the AC Adapter.)

7. Touch screen.
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Power On/Standby and Status Panel
1. Power On/Standby button. Push to

power on or off the instrument. For more
information, access the online help: Start
> Help > Tektronix Basics > Shutting
Down the Instrument.

2. Reset button. Performs a hardware reset;
all programs and data loaded into volatile
memory are erased. Generally only used
to recover from a system lock-up. Use a
thin probe to push the reset button.

3. Power/Display status. Green indicates
that the instrument is powered on. Amber
indicates that the instrument is powered on
but the display is turned off (to conserve
power).

4. Battery status. Green indicates that the
instrument is connected to an external
power source and is charging installed
batteries. Red indicates a low battery.
No color indicates that the batteries are
charged.

Y500 Spectrum Analyzer User Manual 15



Getting Acquainted with Your Instrument

Input/Output Connectors
1. Microphone input

2. Headphone jack

3. Ethernet connector (RJ-45)

4. Serial RS-232 connector

5. PS/2 keyboard connector

6. USB Host connector

7. USB Slave connector
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Signal Connectors
1. IF OUT. For future use.

2. GPS. Connects to the GPS antenna.

3. TRIGGER/TIMING IN. For future use.

4. FREQ REF IN. Connect to an external
frequency reference signal to improve
measurement accuracy.

5. RF IN. The RF Input connects the RF
measurement antenna or input signal
source to the instrument.

Microsoft WindowsCE Elements
The Microsoft WindowsCE user interface is similar to other Microsoft Windows operating systems. You use standard Microsoft
Windows operations to start (run) applications, select and move objects, and open folders or files. For more Microsoft WindowsCE
information, access the online help: Start > Help > WindowsCE Basics.

The Status area, located at the bottom right of the screen, contains icons that include information about the instrument power status.
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The User Interface
1. Command bar. (See page 19, The

Command Bar.)

2. Spectrum Analyzer controls. (See
page 21, The Spectrum Analyzer Controls.)

3. Display controls. (See page 23, Display
Control Buttons.)

4. Measurement drawers. (See page 22,
The Measurement Drawer Buttons.)

5. Measurement mode buttons. (See
page 25, The Measurement Mode
Buttons.)

6. Measurement results. Shows the
waveform displays, measurement results,
and marker readouts. The appearance
of this area changes depending on
the selected measurement mode and
measurement type.
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The Command Bar
Contains the application menus, as well as buttons for running/pausing the application and setting GPS, reference signal, and
external amplifier/attenuator parameters.

Element Description
Menus. See the online help topic Menus for information about the menu functions.

Measurement Display button. Opens a dialog box from which to select the instrument
measurement mode. (See page 30, Select a Measurement Type.)

Run/Pause button. Runs or Pauses the current measurement acquisition.

The GPS status button. Shows the GPS signal lock status of an attached GPS receiver. The
color indicates the GPS receiver signal lock status. Tap this button to open the GPS dialog
box. See the online topic The GPS Dialog Box for more information.
The Measurement Reference Frequency status button. Shows the measurement frequency
reference source. Tap this button to open the Inputs dialog box. Use this button if you connect
an external measurement reference frequency source to the instrument.
The available measurement reference frequency sources are the internal instrument frequency
reference (F INT) and an external reference (F EXT). See the online topic The Inputs Dialog
Box for more information.
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Element Description
The RF Input Signal Gain/Attenuation status button. Shows the external attenuator or amplifier
status. Tap this button to open the Inputs tab where you can set the input signal amplification
or attenuation values. Use this button if you connect an attenuator or amplifier to the input
signal. See the online topic The Inputs Dialog Box for more information.

Help button. Opens the online help. online help is context-sensitive and normally displays a
help topic related to the current measurement mode or screen. If the current screen is not
context-sensitive, the instrument opens the online help at the main help menu. Use the index,
or do a word search, to locate specific information.
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The Spectrum Analyzer Controls
Sets the display reference level (manually or automatically), the frequency span, and the measurement frequency.

Element Description
Reference Level button and field. Shows the current spectrum signal reference
level. Tap the Ref Level button to open a keypad and enter a specific level value.
Tap the Ref Level field to open an increment control to increase/decrease the
current reference level value.
AutoLevel button. Tap the button to automatically detect the maximum input signal
level across the full instrument frequency range and set the Reference Level
appropriately.
Span controls and field. Shows the frequency span of the displayed signal. Tap the
arrow buttons to increment or decrement the span value by the default span units
(1–2–5). Tap the Span field to open a keypad and enter a specific span value.
Measurement Frequency button and field. Shows the spectrum signal measurement
frequency. Tap the Freq button to open a keypad and enter a specific frequency
value. Tap the frequency field to open an increment control to increase/decrease
the current reference level value in steps.
Use the Freq/Span tab (Spectrum drawer > More) to couple or uncouple the
measurement frequency with the display center frequency.
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The Measurement Drawer Buttons

Element Description
Drawer buttons provide additional controls for setting parameters. The displayed set of drawer buttons
changes based on the selected measurement mode. The drawer buttons are always on screen to
provide fast access to the most important controls for that measurement or setting.
Tap on a drawer button to open that drawer. A down-pointing arrow indicates an open drawer.
Tap the More button to open parameter tabs with which you can set additional measurement parameters.
Tap the Help button [?] to display information on that drawer.
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Display Control Buttons
The Display Control buttons let you select the type of signal display, move the signal display area, and turn markers on and off.

Element Description
Spectrum button. Displays the Spectrum measurement. (See page 32, Display a Spectrum Signal.)
When displaying a spectrum, this button is replaced with the DPX™ Spectrum button.
DPX™ Spectrum button. Displays the DPX Spectrum measurement. (See page 37, Display a DPX Spectrum
Signal.)
When displaying a DPX spectrum, this button is replaced with the Spectrum button.
Front Trace button. Selects which trace is in front on the display. Tap the button to cycle through all enabled
traces. The Trace field in the Spectrum drawer shows the front trace name and trace type. See the online help
topic The Trace Tab for more information.
Zoom button. Lets you zoom (expand) the waveform by changing the span. Tap and drag from left to right to zoom
in (expand) the waveform. Tap and drag from right to left to zoom out (shrink) the waveform. The zoom function
only works in the horizontal (frequency span) axis.
In the SC Plot mode, the zoom function works in both the horizontal and vertical axis.
Move Display button. Lets you move the waveform display. Tap and drag on the screen to move the waveform
in a horizontal or vertical direction (you cannot move the display diagonally). The vertical reference level scale
changes to track the movement. If you move the display such that the measurement frequency is off-screen, the
instrument sets the measurement frequency to the nearest edge of the display.
Undo button. Undoes the last touch screen tap or drag action (such as a move or zoom).

Y500 Spectrum Analyzer User Manual 23



Getting Acquainted with Your Instrument

Element Description
Reset button. Clears the current signal data and starts a new signal acquisition.

Display Markers button. Shows or hides marker icons and readouts. See the online help topic The Markers
Tab for more information.
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The Measurement Mode Buttons
The Measurement Mode buttons select the type of measurement or operation to perform.

Element Description
Spectrum Measurement button. Sets the instrument to display spectrum measurements. (See page 32, Display a
Spectrum Signal.)

Spectrogram Measurements button. Sets the instrument to display spectrogram measurements. (See page 34,
Display a Spectrogram.)

iMap button. Sets the instrument to place instrument measurements on a map. Use for graphically recording
measurements to help analyze signal characteristics, locate interference, and save measurement/location
information. (See page 40, iMap Measurement Mapping Mode.)
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Parameter Entry Controls
Tap on a parameter field or button to open the appropriate parameter entry control for that field or button.

Element Description
The Increment control lets you use buttons to increase or decrease the value of the field in
small or large steps. The single arrow buttons make small changes. The double arrow buttons
make larger changes.

Tap a keypad button to open a keypad in which to enter a value in the selected field. The
keypad content changes to show the available entry functions for the selected item.

WindowsCE provides an Input Panel (virtual keyboard) that you can use to enter text such as
file names. In most cases, when the instrument opens a dialog box that includes fields for text
entry, the Input Panel also opens. When you close the dialog box, the Input Panel also closes.

To manually open the Input Panel, tap the WindowsCE Input Panel button ( right-most
icon in the task bar). You can open a standard keyboard or a large keyboard. Tap the Input
Panel button again and select Hide Input Panel to close the keyboard.
You can also open the Input Panel from Tools > Keyboard.
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Getting Help
The application includes a comprehensive online help system. You access the online help using the following methods:

Online help element Description
Help button. Located at the top right of the screen, as well as on most measurement function
drawers or tabs Tap this button to display a help topic that is relevant to the current display mode,
measurement drawer, or tab contents.
Dialog box help button. Tap this button to display an online help topic relevant to that dialog box.
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Operating Basics
Enabling Signal Standards

Enable (select) the signal standards that you expect to analyze or measure. Enabled signal standards are listed in various
fields in the instrument.

1. Select Setup > Signal Standards.

2. Tap the name of the standard in the Signal
Standards supported list that you want
to enable. Drag the stylus to select two or
more contiguous standards.

3. Tap the Add >> button to add the selected
standard(s) to the Signal Standards
selected list.

4. Tap OK. The enabled standards are now
selectable from any Standards drop-down
list.
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Enabling Signal Types
Enable (select) the signal types that you expect to analyze or measure. Enabled signal types are listed in various fields in the
instrument. Use enabled signal types to set measurement parameters such as measurement bandwidth.

1. Select Setup > Signal Types.

2. Tap the name of the standard in the Signal
Types supported list that you want to
enable. Drag the stylus to select two or
more contiguous standards.

3. Tap the Add >> button to add the selected
standard(s) to the Signal Types selected
list.

4. Tap OK. The enabled types are now
selectable from Signal Types drop-down
lists.
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Select a Measurement Type
1. Tap the Measurement Display button.

2. Tap an item in the Category field.

3. Double-tap an item in the Measurement
field to open the selected measurement
display mode.
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Spectrum/Spectrogram Measurements
The spectrum measurement displays the spectral content of a signal (power versus frequency). The spectrum measurement
features include a measurement frequency range of 10 kHz-6.2 GHz that covers most modern signal sources, the ability to
detect very low level signals, seven measurement markers, two signal traces, five trace modes, and intermodulation markers for
quickly checking for this common source of unusual signals.

The Spectrogram measurement displays the spectral content (power versus frequency) of a signal over time, where the signal
amplitude is represented as a color. This display is especially useful for recording intermittent signals, as you can set the
spectrogram to acquire measurements from seconds to days apart, and automatically save the measurements to a file.
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Display a Spectrum Signal

1. Tap the Spectrum mode button.

2. Tap the Freq button and enter a
measurement frequency.

3. Tap the Span controls to change the
displayed frequency span to show the
waveform area of interest. Or tap the Span
field and change the span value using the
Increment control or the Keypad control.

4. Tap the AutoLevel button to set the
display reference level. Or tap the Ref
Level button and enter a value with the
Reference Level keypad.
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Set Other Spectrum Parameters

1. Use the controls in the Spectrum drawer
to set resolution bandwidth (RBW), the
display vertical scale, the measurement
frequency Marker To button actions, and
the waveform trace type.

2. Tap the More button in the Spectrum
drawer to display the spectrum parameter
tabs.

3. Tap a tab to display the parameters set by
that tab.

4. Tap the Help (question mark) button on a
tab to display online help that describes the
parameters for that tab. For example, to
get information on measurement markers,
tap the Markers tab and then tap the help
button.

5. Tap the Close (X) button on a tab to close
the tab display and return the instrument to
a full-screen display mode.

Y500 Spectrum Analyzer User Manual 33



Operating Basics

Display a Spectrogram

1. Display a spectrum signal of interest.

2. Tap the Measurement Display button and
select the Spectrogram measurement.

3. Set or clear the Dual Display check
box in the Spectrogram drawer to
enable or disable a split-screen
spectrum/spectrogram display.

NOTE. If tabs are open, tap the tab Close
button (X) to close the tabs and display the
spectrogram on the lower half of the screen.

4. Tap the More button to display the
spectrogram parameter tabs.

5. Tap the Spectrum display control button to
return to a Spectrum display.

See the online spectrogram help topics for information on other spectrogram operations.
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View a Spectrogram Record

1. Display a spectrogram.

2. Tap the Stop button to stop measurement
acquisition.

3. Tap the Data Record field in the
Spectrogram drawer to open the Data
Record increment control.

4. Tap the arrow keys to move the record
cursor (white line in the spectrogram plot)
to a record of interest. The Spectrogram
drawer shows the time and date information
of the selected record directly below the
Data Record field.

5. The spectrum display shows the waveform
for the selected record (in dual display
mode).
See the online help topic View Saved
Spectrogram Files for information on
viewing saved spectrogram records.
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DPX™ Spectrum Measurement
DPX Spectrum technology enables you to see how traces change over time and thus displays signal events that cannot be seen
on a swept spectrum analyzer. A DPX Spectrum indicates how traces change in two ways. First, it uses color shading to show
how consistent the shape of a trace is. Color reflects the rate-of-occurrence for signal features. Second, DPX Spectrum uses
persistence to show how the trace shape changes.

The DPX Spectrum display works by using a two-dimensional array to represent data points on the display. Each time a trace writes
to a point on the display, the instrument increments a counter for that point. A color is assigned to each point in the display based
on the value of its counter divided by the number of acquisitions (hit percent). Thus, as acquisitions occur over time, the DPX
waveform, referred to as the Bitmap, uses color to show how frequently a display point has been written to.

An important feature of the DPX Spectrum display is persistence. Persistence sets how long a point on the display is visible. You
can set the display persistence to be Variable or Infinite. In variable persistence mode, you set a decay period that determines how
long a point is displayed. In infinite persistence mode, once a point in the display has been written to, it remains visible indefinitely.
Persistence lets the spectrum analyzer display infrequent events.
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Display a DPX Spectrum Signal

1. Display a spectrum signal of interest. (See
page 32, Display a Spectrum Signal.)

2. Tap the DPX Spectrum display control
button.
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3. Tap the More button in the DPX Spectrum
drawer to display the DPX spectrum
parameter tabs.

4. Tap the Bitmap tab.

5. Tap the Intensity field and set the intensity
to control the visibility of events. A higher
intensity level enables the display of data
points from single, short events, and also
makes such an events subject to the
persistence controls. This allows you to
see the effect of the Persistence controls
on infrequent events. Intensity also affects
the colors used to display the Bitmap.

6. Tap the Dot Persistence check box to
enable Bitmap point display persistence
controls. Dot persistence sets how long a
point is displayed if it is not updated with
new data.
Variable sets the decay period for how long
a point is displayed before fading.
Infinite sets all points to remain visible
indefinitely until you restart signal
acquisition.
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7. Use the Color field to set the color scheme
used for the Bitmap trace.

8. Use the Max and Min fields to set the hit
percent color range of data points. Data
points that are between the Max and Min
settings are displayed using the colors in
the order shown in the color scheme.
Max sets the hit percent required to display
a data point using the color at the top of the
color scheme. The default value is 100%.
For example, if the Max value is set to 90%,
then data points that occur 90% or more of
the time are displayed using the maximum
(top) color of the color scheme.
Min sets the minimum hit percent required
to display a data point, starting with the
color at the bottom of the color scheme.
The default value is 0%.
For example, if the Min value is set to 10%,
then data points must occur at least 10% of
the time to be displayed in the Bitmap.
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iMap Measurement Mapping Mode
iMap integrates interference mapping, coverage mapping, in-building mapping, outdoor mapping, and provides an integrated
solution for field interference and coverage problems in one instrument.

Using iMap is as easy as selecting a measurement and touching the displayed map where you want the measurement to be placed.
Measurement icons are color coded to indicate if the measurements have passed or failed limit tests. You can also add a direction
arrow to a measurement to indicate the direction the antenna was pointing when you took a measurement.

To start the iMap tool, tap the iMap button.
When you open the iMap tool for the first time,
the screen displays the message Empty map.
Otherwise, iMap displays the last-loaded map.

You can load scanned bitmap files as maps for in-building mapping, or use GSF and MIF map file formats for outdoor maps. Using
GSF or MIF map files lets you use the built-in GPS receiver to automatically place measurements at your current location.

You can save maps and associated measurement results data to common file formats such as CSV or MapInfo. Saving maps and
measurement results lets you analyze measurement data (position, value, and direction) and prepare reports.
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Map File Concepts
The iMap tool uses two types of maps: Grid and Image.

Grid Maps. Grid maps have geophysical latitude and longitude coordinate references embedded in the map file. The instrument
uses grid maps, along with an active GPS receiver, to place measurements on a map at your current geophysical position.
Grid maps require specialized PC software to create or can be purchased from map-creating companies. The instrument can
load both GSF- and MIF-format grid map files. You need to convert non-GSF or MIF grid maps to GSF format before you can
load them into the iMap tool.

Grid maps require an active GPS receiver to correctly link measurements to geophysical map locations. An active GPS receiver
is a receiver that is locked to four or more satellite signals and is providing the instrument with accurate GPS location data. If
you load a grid map and a GPS receiver is either not connected or does not have a good satellite signal lock, the instrument
considers the grid map as an image map.

Image Maps. Image maps do not have any geophysical latitude and longitude references embedded in the map file. An image
map is a graphical image, such as a scanned building floor plan or aerial photograph, to which you can attach measurements
at the point that you tap the screen.

Converting Files to Maps. The iMap Converter, a program that is downloadable from the Tektronix Web site, lets you convert
and save image files (BMP, JPEG, GIF, TIFF or PNG file) into GSF format image map files, convert image maps to grid maps, and
create grid maps from Google Earth or Microsoft MapPoint applications. (See page 54, The iMap Converter Program.)
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Loading a Map
You need to load a map before you can use the iMap tool. If a map was loaded in a previous session, then that map remains
loaded until you load a new map file.

1. With iMap open, select File > Load Map.

2. Navigate to and select the map file to
load (Bitmap, GSF, MIF, or ZIP (map with
results) format).

3. Tap OK. The iMap application loads the
map on the screen.
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Mapping a Measurement
The following procedure requires that you have already set up the measurement. You must have also loaded a map file. (See
page 42, Loading a Map.)

1. Tap the Single Measurement button.

2. Tap an iMap measurement button.
Available measurements depend on
the current signal standard. The
selected measurement is displayed in the
Measurement Thumbnail area.
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3. Tap the map:

If a GPS receiver is active, and
you are using a grid map, a single
measurement is placed at the current
GPS coordinates.

If a GPS receiver is not active, or if
you are using an image map (such
as a building floor plan), a single
measurement is placed where you
tapped the map.

4. You can select a different measurement
button, and then tap the map to add a
new measurement to the map. Multiple
measurement icons at the same location
stack on top of each other.
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5. To move an icon, tap the Select button
and then tap and drag the icon to a new
position. If the measurement was part
of a stack of measurements (such as
created by logging), then iMap moves the
topmost icon in the stack. If the icon is
moved to a new stack of measurements,
then the icon is placed in the stack in
time-of-measurement order.

NOTE. To add measurements at a new location on a grid map with an active GPS receiver, you must physically move to the
new location.

NOTE. You can move measurement icons on an image map, or on a grid map with the GPS receiver inactive. Attempting
to move an icon on a grid map with an active GPS receiver causes iMap to drag the map and its measurement icons to a new
position on the screen; the measurement icons are not moved.

When a GPS receiver is not active, you can move any measurement icon. This includes moving measurement icons that were
placed on the map while in GPS mode. iMap does not reposition moved GPS-related measurement icons back to their original
geophysical position on a map when the GPS receiver is active.
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iMap Measurement Icons
The iMap application uses icons on the map to represent a measurement taken at that location. There are two types of
measurement icons: large and flag. The large icon displays the type of measurement that they represent. The flag icon is a simple
small flag, and is used only in logging (multiple) measurement mode to indicate measurement placement. See the online help topic
iMap Measurement Map Icon Types for more information.

You can perform various actions on measurement icons, including viewing the measurement results of an icon, moving the icon,
deleting an icon, and attaching a measurement direction arrow to an icon. See the following sections, and the online help topic
View Map Measurements, for more information.

Viewing and Deleting Icon Measurements
To view or delete the measurement results associated with an iMap measurement icon:

1. Tap the iMap Select mode button.

2. Tap a measurement icon to open the Map
Measurements dialog box.
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3. Tap the measurement of interest in the list.

4. Tap Open Measurement to open the
measurement screen for the selected
measurement. Tap the iMap button to
return to the iMap screen.

5. Tap the Delete Measurement button to
delete the selected measurement. If there
are multiple measurements to delete,
repeatedly select and tap Delete.

6. Tap Measurement to Top to move a
selected measurement to the top of the list.

7. Tap OK to close the dialog box.

NOTE. You can also double-tap on a measurement icon to open the measurement window for that measurement. If there are
multiple measurements at a location, double-tapping an icon displays the results for the measurement icon that is at the top of
the list.

To delete all the measurement icons from a map, select File > Clear All Measurements.
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Draw a Measurement Direction Arrow
The iMap direction arrow function lets you draw an arrow on a mapped measurement icon. You can use the arrow to indicate the
direction your antenna was pointing when you took a measurement.

1. Tap the Measurement Direction button.

2. Tap and drag from the center of a
measurement icon in the direction
the antenna was pointing when the
measurement was made. iMap draws an
arrow from the measurement icon.

3. To change the arrow direction, draw a new
line. iMap replaces the existing arrow with
the new direction arrow.
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Delete a Measurement Direction Arrow.

1. Tap the iMap Select mode button.

2. Single-tap the measurement icon with the
direction arrow to delete. iMap opens the
Map Measurements dialog box.

3. Tap the measurement name that has the
direction arrow to delete.

4. Tap the Delete Arrow button.

5. Tap OK. iMap closes the dialog box and
deletes the direction arrow.
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Logging iMap Measurements (Automatic Measurements)
Logging measurements lets you automatically map a single measurement at a set time interval or change in GPS position (with
active GPS receiver and a grid map).

NOTE. The iMap tool maps only completed measurement results. If the specified time interval is less than that required to take a
measurement, iMap ignores the specified time interval and maps results as soon as the measurement acquisition is done.
For example, if the instrument requires 20 seconds to take a measurement, but the time interval is set to 10 seconds, then
the instrument maps results every 20 seconds.

1. Tap a measurement button.

2. Tap the Log Measurements button.
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3. Tap a button in the Measure By area to
set the type of measurement interval (time
interval or distance between measurement
positions). Distance is only available when
the GPS is active and acquiring accurate
position data.

4. Tap a field in the Measure Every area to
set the measurement interval.

5. Tap the map to start logging measurements:

For grid maps with an active GPS
receiver, tap the map at any point. The
instrument adds measurement flags to
the map at the current GPS position.

For image maps or for grid maps
without an active GPS receiver, tap
the map at the measurement starting
location. The instrument begins taking
measurements, but does not display
them on the map until measurement
logging is done.
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6. Tap the map to stop measurements:

For grid maps with an active GPS
receiver, tap the map at any position.
The instrument stops mapping
measurements.

For image maps or grid maps without
an active GPS receiver, tap the map at
the position the last measurement was
taken. Measurements are then evenly
spaced on a straight line between the
start and stop map points.

7. Tap the Single Measurement or the Select
button to exit the logging measurements
mode.
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NOTE. The iMap Log measurements function automatically sets the map view measurements mode to Measurement Flags during
logging measurement acquisition. When iMap measurement logging is done, the instrument restores the map view measurements
mode to the mode it was at before the iMap measurement logging was initiated.

If you tap the Select, Measurement Direction, or Single Measurement button while logging measurements in non-GPS mode,
iMap cancels the log measurements mode and does not draw any measurement icons on the map.

Grid maps with an active GPS receiver support logging measurements by time interval or distance change interval. Image maps, or
grid maps with an inactive GPS receiver, support logging measurements by time intervals.

You cannot place a measurement icon on any area of the map that is covered by a message banner.
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The iMap Converter Program
Tektronix provides a map file conversion program called iMap Converter that you can download from the Tektronix Web site.
iMap Converter lets you convert graphical image files or map files for use with the instrument iMap tool. Types of images or
files that you can convert include:

BMP, JPEG, GIF, TIFF and PNG graphical images (map images, building floor plans, aerial photographs)

Industry standard MapInfo Interchange Format (MIF), ArcInfo Shape (.shp), USGS Digital Line Graph (.opt) geophysical
coordinate maps

Other iMap Converter features include:

Easily capture images from Google Earth or Microsoft MapPoint to create geophysical (coordinate) map files for use with
GPS measurement mapping

Manually assign geophysical coordinates (latitude/longitude) to image files, such as building floor plans or screen capture map
images, to create a grid map for use with GPS measurement plotting

Combine multiple coordinate map files into a single large map file

To install the iMap Converter program on a PC:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Click Software Downloads on the left side of the screen to open the Software Downloads Web page.

3. Enter imapconverter (single word) in the Search by keyword field and click Go.

4. Select the iMap Converter link to download the software. Follow the installation instructions on the download page.

5. To open the iMap Converter tool on the PC, select Start > Programs > Tektronix > iMapConverter.
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6. Click the iMap Converter Help button for information on how to use the tool to convert files, add coordinates to an image file,
or create maps from Google Earth or Microsoft MapPoint.

NOTE. Bitmap files that are converted to GSF-format load faster on the instrument because the instrument does not have to do the
bitmap-to-GSF conversion in the instrument. However, it is then possible to confuse image GSF maps with grid (coordinate) GSF
files. Use a file naming convention to differentiate between GSF maps created from coordinate maps and GSF maps created
from bitmap files that do not have coordinate information.

NOTE. The MIF-format files take significantly longer to load than the GSF-format files. Tektronix recommends that you use iMap
Converter to convert MIF map files to GSF map files, rather than loading MIF files directly on the instrument.
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Specifications
This section lists the electrical, environmental, and physical specifications for the Y500 Spectrum Analyzer. All specifications are
guaranteed unless labeled “typical.” Typical specifications are provided for your convenience and are not guaranteed.

Table 1: General Performance Characteristics

Characteristic Description
RF Input

Operating Frequency
Range

10 kHz – 6.2 GHz
Operating Range for some features may be restricted. If so, the restricted range is defined with
the relevant feature.

Maximum Operating
Input Level

+20 dBm peak envelope power
This is the maximum input level at which the instrument will meet its performance specifications.
For a signal without any amplitude variation, peak envelope power = rms.

Maximum Input Power
without Damage

50 W rms below 3.2 GHz
15 W rms between 3.2 GHz and 6.2 GHz

Internal Timebase
Error ± 0.5 PPM from 0 °C to 50 °C

± 1.0 PPM aging/year
Twenty minute warm-up period required to meet accuracy specification
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Table 1: General Performance Characteristics (cont.)

External Reference Input
Impedance 1500 ohms
Frequency Range 1 MHz up to 20 MHz ± 1 PPM in 1 MHz steps
Input Level Range –15 dBm to +15 dBm, 1 MHz to 15 MHz

–10 dBm to +15 dBm, 16 MHz to 20 MHz
dBm levels assume 50 ohm source

Table 2: Spectrum Analyzer Characteristics

Characteristic Description
Center Frequency

Range 10 kHz to 6.2 GHz, preamp off
10 MHz to 6.2 GHz, preamp on

Setting Resolution 1 Hz
Span

Range 1 kHz to 6.2 GHz
Setting Resolution 1 Hz
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Resolution Bandwidth
Range 10 Hz to 3 MHz (Manual RBW)

10 Hz to 1 MHz (Auto RBW)
Setting Resolution 1 Hz

Spectral Purity
Displayed Average
Noise Level, Preamp
On

–153 dBm, 10 MHz to 2 GHz, 10 Hz RBW
–152 dBm, 2 GHz to 4 GHz, 10 Hz RBW
–151 dBm, 4 to 5 GHz, 10 Hz RBW
–145 dBm, 5 to 6.2 GHz, 10 Hz RBW
Reference Level ≤ (DANL + 90 dB)

Phase Noise ≤ -95 dBc/Hz @ 10 kHz offset
≤ –95 dBc/Hz @ 20 kHz offset
≤ –95 dBc/Hz @ 30 kHz offset
≤ –97 dBc/Hz @ 100 kHz offset
≤ –110 dBc/Hz @ 1 MHz offset

Residual Spurious,
Preamp Off

≤ –90 dBm, 0 dBm attenuator setting
Exception frequencies:
9 MHz to 19 MHz center frequency
3464 MHz center frequency
4592 MHz center frequency
5374 MHz to 5378 MHz center frequency
6160 MHz center frequency
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Residual Spurious,
Preamp On

≤ –105 dBm, 0 dBm attenuator setting
Exception frequencies:
9 MHz to 19 MHz center frequency
5374 MHz to 5378 MHz center frequency

Third Order IMD ≤ –70 dBc for two tones at or below the reference level, preamp off, all gain settings Auto-coupled
Second Harmonic ≤ –60 dBc for a single tone at or below the reference level, preamp off, all gain settings Auto-coupled
Input Related
Spurious

≤–70 dBc except for Fin= 2.282 GHz ± 20 MHz
The reference for ’dBc’ for this specification is the total power of all signals present at the input of
the instrument regardless of the current span

Input Related
Spurious, exception
frequencies, typical

≤ –55 dBc except for Fin= 2.282 GHz ± 20 MHz
The reference for “dBc” for this specification is the total power of all signals present at the input of
the instrument regardless of the current span

Third Order Intercept ≥ +7 dBm, 0 dB Input Attenuation, Preamp Off
Spectral Display Amplitude

Reference Level
Range

+20 dBm to –160 dBm

Marker Power
Accuracy

±1.75 dB, –50 dBm ≤ input ≤ +20 dBm, preamp off
±3.0 dB, –80 dBm ≤ input < –50 dBm, preamp on, above 10 MHz
±3.75 dB, –120 dBm ≤ input < –80 dBm, preamp on, above 10 MHz
Use peak detector for CW-like signals; use average detector for wideband (signal >> RBW)
Accuracy guaranteed for CW signals and span set to 20 MHz or less
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Display
Display Modes Normal - updates display with each new result

Max Hold - updates displayed point only if new point > old
Min Hold - updates displayed point only if new point < old
Max/Min Hold - displays a vertical bar between Max Hold and Min Hold
Average - displays average of N (specified by user) acquisitions
Average is calculated as follows:
Last N values are saved in memory; when a new result is available, the earliest result of the N
stored values is discarded, the new result is added to the stored values, and a new average
is calculated from the stored values
If the number of results is less than N, then all of the results are averaged together

Number of Averages 1 ≤ N ≤ 200

Table 3: DPX Measurements Processing Characteristics

Characteristic Description
Spectrum Processing
Rate, nominal

2,500 per second (span independent)

Minimum Signal Duration
for 100% Probability of
Intercept, typical

500 μs

Span Range 20 kHz to 20 MHz
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Table 4: General Purpose RF Measurements Characteristics

Characteristic Description
General Purpose RF Channel Power Measurement

Measurement
Bandwidth Range

1 kHz - 20 MHz

Accuracy ≤1.2 dB; +20 dBm to –60 dBm; Resolution BW < 100 kHz
+20 dBm to –40 dBm; Resolution BW ≥ 100 kHz
1 MHz to 3.2 GHz , preamp off
≤2 .4 dB; –60 dBm to –75 dBm; Resolution BW < 100 kHz
–40 dBm to –55 dBm; Resolution BW ≥ 100 kHz
10 MHz to 3.2 GHz , preamp on
≤1.8 dB; +20 dBm to –50 dBm; Resolution BW < 100 kHz
+20 dBm to –40 dBm; Resolution BW ≥ 100 kHz
3.2 GHz to 6.2 GHz , preamp off
≤3 dB; –50 dBm to –75 dBm; Resolution BW < 100 kHz
–40 dBm to –55 dBm; Resolution BW ≥ 100 kHz
3.2 GHz to 6.2 GHz , preamp on
Specifications apply for default control settings (Auto RBW, Auto Level)

Occupied Bandwidth Measurement
Percent Power
Inclusion Range

50% - 100%
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Table 4: General Purpose RF Measurements Characteristics (cont.)

RF Field Strength
Channel Bandwidth
Range

Same as Channel Power

Accuracy Same as Channel Power

Table 5: Signal Analysis and Monitoring Characteristics

Characteristic Description
AM Demodulation Provides an audio output signal after AM demodulation of the user-selected signal.

Measurement
Frequency

As previously selected

Minimum Input Signal
Level, Typical

-100 dBm

Audio Measurement
Bandwidth

8 kHz

FM Demodulation Provides an audio output signal after FM demodulation of the user-selected signal.
Measurement
Frequency

As previously selected

Minimum Signal
Level, Typical

-100 dBm
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Table 5: Signal Analysis and Monitoring Characteristics (cont.)

Maximum Signal
Deviation

Up to 100 kHz

Audio Measurement
Bandwidth

8 kHz, 15 kHz, 75 kHz, or 200 kHz

Maximum Audio
Output Bandwidth

15 kHz

Signal Strength Indicator Provides both an audio tone and a visual display that are related to the strength of the user
selected signal

Input Signal Level -120 dBm, minimum
Measurement
Frequency

As previously selected

Measurement
Bandwidth

Up to 20 MHz, dependent upon span and RBW setting

Tone Type Variable beep rate or variable frequency
Update Rate, Typical 10 per second
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Table 6: Environmental characteristics

Characteristic Description
Temperature Operating: 0 °C to +50 °C specified performance, –10 °C to +50 °C, typical

Nonoperating: –40 °C to +60 °C
The temperature specs above are modified with the following options installed:
Li-Ion Batteries: Charge 0 °C to +45 °C, Storage –20 °C to +60 °C

Humidity Operating and Nonoperating: 5% to 95% relative humidity (RH) at up to +30 °C, 5% to 45% RH
above +30 °C up to +50 °C, noncondensing

Altitude Operating: Up to 4,600 meters (15,092 feet)
Nonoperating: Up to 12,192 meters (40,000 feet)

Table 7: Physical characteristics

Characteristic Description
Dimensions Height: 25.5 cm. (10.0 in)

Width: 33 cm. (13 in)
Depth: 12.5 cm. (4.8 in)

Weight 6.0 kg (13.25 lbs): instrument and 1 battery
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Table 8: Miscellaneous characteristics

Characteristic Description
Recommended Instrument
Calibration Interval

2 years

Table 9: Safety compliance

Category Description
Safety Compliance ANSI/UL61010-1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
CSA C22.2 No. 61010.1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
EN 61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
IEC61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
ISA 82.02.01

Electrical Equipment for Measurement, Control, and Laboratory Use.
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Certifications and Compliances
EC Declaration of Conformity – EMC
Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326:1997. EMC requirements for Class A electrical equipment for measurement, control, and laboratory use. 1, 2, 3, 4

IEC 61000-4-2:1999. Electrostatic discharge immunity (Performance criterion C)

IEC 61000-4-3:2002. RF electromagnetic field immunity (Performance criterion A) 5

IEC 61000-4-4:2004. Electrical fast transient / burst immunity (Performance criterion B)

IEC 61000-4-5:2005. Power line surge immunity (Performance criterion B)

IEC 61000-4-6:2003. Conducted RF immunity (Performance criterion A) 5

IEC 61000-4-11:2004. Voltage dips and interruptions immunity (Performance criterion B)

EN 61000-3-2:2000. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom
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1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.
4 Minimum Immunity test requirement.
5 Performance Criteria: Residual spurious signals can increase to –70 dBm with exposure to the disturbance levels of this test.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

EN 61326:1997. EMC requirements for electrical equipment for measurement, control, and laboratory use.
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Index
Symbols and Numbers
? button, 27

A
AC adapter requirements, 2
AC adapter, connecting, 6
AC/DC adapter connection, 14
Accessories (standard), 1
Active GPS (definition), 41
Adapter, AC, connecting, 6
Add signal standards to selection

lists, 28
Add signal types to selection lists, 29
Altitude specifications, 2
Amplifier setting (RF input signal), 20
ArcInfo Shape (.shp) map file, 54
Attenuator setting (RF input signal), 20
AutoLevel button, 21
Automatic iMap measurements, 50

B
Battery

charge status, 15

charge times, 7
charging, 7
compartment door location, 14
installing, 4

Bitmap (DPX), 36
Bitmap file (iMap), 41
BMP, 41
Button

AutoLevel, 21, 32
display markers, 23
F EXT, 19
F GPS, 19
F INT, 19
Freq, 32
front trace, 23
GPS status, 19
help, 27
Help, 19
iMap log measurements, 50
iMap mapping mode, 25
log measurements (iMap), 50
measurement frequency, 21
measurement mode buttons, 25

measurement reference
frequency status, 19

move display, 23
Pause, 19
power on/standby, 15
Ref Level, 21, 32
reset, 15
reset measurement, 23
RF input signal gain/attenua-

tion, 20
Run, 19
span, 21
spectrogram, 23
spectrogram measurement

mode, 25
spectrum measurement

mode, 25
undo display action, 23
zoom display, 23

C
Calibrate the touch screen, 10
Certifications and compliances, 67
Change
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spectrum frequency span, 32
Changing

application screen colors for
printing, 13

numbers in fields, 26
Charging the batteries, 7
Cleaning the instrument and

touch-screen, 3
Color schemes (user interface), 13
Command bar, 18, 19
Concepts (touch screen), 9
Connecting the AC adapter, 6
Connectors

FREQ REF IN, 17
GPS, 17
IF OUT, 17
input & output, 16
RF IN, 17
signal input/output, 17
TRIGGER/TIMING IN, 17

Conventions used in this manual, x
Converting maps to GSF, 54

D
Definition

active GPS receiver, 41

grid map, 41
image map, 41

Delete a direction arrow (iMap), 49
Delete measurement icons (iMap), 46
Dimensions, 2
Direction arrow (iMap), 48
Direction arrow, how to delete

(iMap), 49
Display a DPX spectrum, 37
Display a spectrogram, 34
Display markers button, 23
Displaying

a spectrum waveform, 32
power on/off status, 15

Documentation, ix
Dot Persistence (DPX), 38
DPX Spectrum

Bitmap, 36
Bitmap tab, 38
display control buttons, 23
Dot Persistence, 38
Hit percent, 36, 39
how to display, 37
Infinite persistence setting, 38,

39
Intensity field, 38
Max setting, 39

Min setting, 39
overview, 36
Persistence, 36
Variable persistence setting, 38

Drag (touch screen), 9
Drawing a measurement direction

arrow (iMap), 48

E
EC Declaration of Conformity, 67
Electrical storm, preventing personal

injury, xi
EMC Declaration, 67
Enabling

signal standards, 28
signal types, 29

Entering numbers in fields, 26
Erase a direction arrow (iMap), 49
Ethernet connector (RJ-45), 16
External RF input signal amplifier, 20
External RF input signal attenuator

setting, 20
External timing reference signal

input, 17
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F
Freq button, 21
FREQ REF IN connector, 17
Frequency span (spectrum), 32
Front trace button, 23
Functional verification, 8

G
Getting help, 27
GPS and maps, 41
GPS connector, 17
GPS status button, 19
GPS, active, definition, 41
Grid map (iMap), 41
.gsf, 41
GSF, 41
GSF, converting maps to, 54

H
Headphone jack, 16
Help

accessing online help, 27
button, 19

Hit percent (DPX), 36, 39
Humidity operation specifications, 2

I
I/O port locations, 14
IF OUT connector, 17
Image map (iMap), 41
iMap

change the direction of a direction
arrow, 48

delete a direction arrow, 49
delete measurement icons, 46
draw a measurement direction

arrow, 48
erase a direction arrow, 49
icon types, 46
loading a map file, 42
log measurements button, 50
logging measurements, 50
map conversion, 54
map file concepts, 41
mapping a measurement, 43
mapping mode button, 25
measurement icon types, 46
measurement icons, delete, 46
measurement mapping, 43
move a measurement icon, 45
overview, 40
plot a measurement on a map, 43

remove a direction arrow, 49
start iMap mode, 40
take automatic map

measurements, 50
view measurement icon

values, 46
view measurement values of an

icon, 46
iMap Converter, 54
Increment control, 26
Indoor color scheme, 13
Infinite persistence setting (DPX), 38,

39
Input field entry controls, 26
Input signal characteristics, 2
Input voltage requirements, 2
Input/Output connectors, 16
Installing batteries, 4
Instrument cleaning, 3
Instrument connectors, 14
Instrument elements, 14
Intensity field (DPX), 38

K
Key features, viii
Keypad button, 26
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L
Lightning, preventing personal

injury, xi
Loading a map file (iMap), 42
Log measurements button (iMap), 50
Logging iMap measurements, 50

M
Map file concepts (iMap), 41
Map file conversion program, 54
MapInfo Interchange Format (.mif)

map file, 54
Mapping a measurement, 43
Max setting (DPX), 39
Measurement

delete a measurement direction
arrow (iMap), 49

display control buttons, 23
draw a measurement direction

arrow (iMap), 48
drawers, 18
iMap icon types, 46
mapping a measurement

(iMap), 43
mode buttons, 18, 25

reference frequency status
button, 19

results screen, 18
select measurement to

display, 30
view iMap measurement icon

values, 46
Menus, 19
Microphone input, 16
Microsoft WindowsCE user

interface, 17
.mif, 41
MIF, 41
Min setting (DPX), 39
Move a measurement icon (iMap), 45
Move signal display button, 23

O
Off (power), 8
On (power), 8
Online help, 27
Opening Y500, 12
Operating basics, 28
Operating considerations, 2
Outdoor color scheme, 13
Overview (iMap), 40

P
Parameter entry controls, 26
Parts of the instrument, 14
Pause button, 19
PCMCIA ports, 14
Persistence (DPX), 36
Plot measurements (iMap), 43
Power

AC adapter requirements, 2
On/Standby button, 15
powering on and off the

instrument, 8
status panel, 14

Power/Display status, 15
Preventing personal injury from

lightning, xi
Product features, viii
PS/2 keyboard connector, 16

R
Ref Level button, 21
Remove a direction arrow (iMap), 49
Reset button, 15
Reset measurement button, 23
RF IN connector, 17
RF input
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characteristics, 2
signal gain/attenuation

button, 20
Run button, 19
Running Y500, 12

S
Safety Summary, iii
Screen display colors, 13
Select a measurement type, 30
Serial RS-232 connector, 16
Set other spectrum parameters, 33
Setting

display colors, 13
signal standards, 28
signal types, 29

Signal input characteristics, 2
Signal input connectors

Reference Frequency Input, 17
RF Input, 17
TRIGGER/TIMING IN, 17

Signal standards
add signal standards to selection

lists, 28
enabling, 28

Signal types

add signal types to selection
lists, 29

enabling, 29
Software upgrades, x
Span, 32
Span buttons, 21
Specifications, 57
Spectrogram

display spectrogram button, 23
dual spectrum/spectrogram

display, 34
how to display, 34
view a data record, 35

Spectrum
control descriptions, 21
display control buttons, 23
displaying a waveform, 32
main controls, 18
measurement mode button, 25
parameter tabs, 33
set frequency span, 32
set measurement frequency, 32
set other spectrum

parameters, 33
set reference level, 32

Spectrum Drawers, 22
Spectum Measurement

spectrum measurement drawer
description, 22

Standard accessories, 1
Starting Y500, 12
Status panel, 15
Stylus (touch screen), 9

T
Taking a spectrum measurement, 32
Tap (touch screen), 9
Temperature range operation

specifications, 2
Thunderstorms, preventing personal

injury, xi
Touch screen

calibrate, 10
concepts, 9
drag, 9
on/off status, 15
stylus, 9
tap, 9
Using the touch screen

interface, 9
Touch-screen cleaning, 3
TRIGGER/TIMING IN connector, 17
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U
Undo display action button, 23
Unpack the instrument, 1
Upgrades, software, x
USB Host connector, 16
USB Slave connector, 16
User interface

color schemes, 13
command bar, 18, 19
measurement drawers, 18
measurement mode buttons, 18
measurement results screen, 18
menus, 19

overview, 18
spectrum analyzer controls, 18
WindowsCE elements, 17

USGS Digital Line Graph (.opt) map
file, 54

Using the touch screen, 9

V
Variable persistence setting (DPX), 38
Verifying instrument functionality, 8
View a spectrogram record, 35

View measurement icon contents
(iMap), 46

W
Weight, 2
WindowsCE user interface, 17

Z
Zoom display button, 23
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